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Overview

Welcome to Virtus WalkThrough VRML 1.0!

VRML (Virtual Reality Modeling Language) is an exciting new technology which will soon change
computing for the masses. We've been developing 3-D visualization products for Macintosh and
Windows for the last five years and are excited about the release of Virtus WalkThrough VRML
1.0.

Our WWW address is HTTP://WWW.VIRTUS.COM. Please visit us and enter your VRML files
(created with Virtus WalkThrough VRML 1.0) into our Model of the Month contest. Also, you'll
want to explore other VRML worlds accessible from our home page.

About WalkThrough VRML 1.0

WalkThrough VRML is a "lite" version of Virtus WalkThrough Pro with VRML export added as its
main feature. It fully demonstrates the ease of use and powerful features offered in the full
version of Virtus WalkThroughPro 2.0. However, some valuable features found in WalkThrough
Pro 2.0 have been removed including: texture mapping, smooth shading, importing, exporting
(except VRML of course), making movies and the lighting editor. In addition, limitations of a
single open model and library, and a single modeling layer have been imposed. That said, with
this version you'll be able to build save models that you've created, and then easily export them
to VRML format with a single menu selection.

We hope you enjoy Virtus WalkThrough VRML 1.0 so much that you'll purchase Virtus
WalkThrough Pro 2.0 or one of the other quality software products in the Virtus family.
WalkThrough Pro is widely available for sale on the internet, in major computer software mail-
order catalogs, and directly from Virtus Corporation.

Modeling Concepts
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The WalkThrough Interface
Click on an area to see information about it:
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Other Virtus Products
Click on a product to view its description:

Virtus WalkThrough Pro 2.0

Virtus VR

Virtus Galleries
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Troubleshooting

Virtus WalkThrough VRML will work best in the 640x480 resolution with 256-colors mode.
Keep in mind that selecting thousands of colors for your display or choosing a larger resolution
(1280x1024, for example) will require more dynamic memory and these choices will slow your
walk speed considerably.

When "Snapshot" in the File Menu is selected, some users may get the screen message
"Can't interrogate driver". This means that the display card being used doesn't support the
standard Windows call being made to create the snapshot. Short of upgrading to a card that
supports all standard Windows calls, you could use the "Snapshot" command by going to
Windows Setup and choosing another video driver; the Windows 3.11 (latest version) SVGA
drivers work well.

Printing works with most combinations of video cards and printer drivers. However, you
may experience some difficulty when printing. First, make sure that the active window is the view
that you want to print, then print. If you still encounter difficulties, turn off FlashGraphics in the
Rendering Preferences and try again. If you still experience problems, use the File Snaphot BMP
command to save your Walk View as a BMP file and then print it with another application that you know 
works with your printer. You can also check with your printer manufacturer to see if you are using the 
latest printer driver available.

Only one Virtus WalkThrough VRML model and library may be open at anytime. When a
library is open, the "Library" command under the File menu will be grayed out (unavailable). If
your walk speed is very slow (e.g. 2 frames per second in a very simple model), you probably
have an ATI Mach 32- or 64-bit board, neither of which supports our Flash Graphics utility.
Check under Rendering in Preferences; if Flash Graphics is grayed out, turn off "devicebitmap"
for your video board. Here's how:

ATI Mach 32: If you have an ATI Graphics Ultra Pro display card, you'll need to make an
adjustment to its mach32 driver. In the "win.ini" file located in your Windows directory (open this
file with Windows Notepad), find the section called "mach32" or "mach." Now find the line
"devicebitmap=on" and change it to "devicebitmap=off." Save the file and restart Windows; Virtus 
WalkThrough VRML will run properly. If there is no "devicebitmap=" statement, you must go to the Flex 
Desk control panel in Program Manager. Open the control panel and select the
advanced option. You should see a listing for devicebitmap. Turn it off, save your changes and
restart Windows.

ATI Mach 64: Go to the Flex Desk control panel and hold down the Control and Shift keys while you type 
the letters, OPT. When the dialog box will appears, click OK.    A second dialog box will open that contains 
the option to turn off devicebitmap. Turn off "devicebitmap", save your changes and then restart Windows.

Models and libraries are organized in two subdirectories, Models and Library. You must be
in the appropriate subdirectories in order to see them. Models have the .WLK extension and are
located in the Models subdirectory. They can be accessed by performing a File Open command
from the menu, and then opening the Models subdirectory to see the list of available models.
Libraries have the .WLB extension and are located in the Library subdirectory. They can be
accessed by performing a File Library command from the menu, and then opening the Library
subdirectory to see the list of available libraries. You cannot open a library by doing the File
Open command; you must perform a File Library command. Models and Libraries can be stored 
anywhere that you wish.

In rare instances, you may experience a GPF when running Virtus WalkThrough VRML, so
remember to save your work often. When you get a GPF, it usually means that your display
driver does not fully support our FlashGraphics utility. The VGA and SVGA display drivers



supplied with Windows work properly with Virtus WalkThrough VRML (provided that your display adapter 
supports them). Please consult your Windows manual for instructions on how to change
your video driver.

Objects may appear to flash on and off as you walk through a file. Virtus WalkThrough
VRML mathematically calculates each new view as you are walking. The more complicated your
model, the more calculations are required to render your new position. Occasionally,
WalkThrough has trouble rendering everything 100% correctly; we call these sorting errors. To
improve rendering of objects, first check for overlapping objects. If there are no intersecting
objects, then you may want to recreate the "flashing" object in a different design view.
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Technical Support

Registration

Registered users will receive special offers on Virtus Products and limited technical support. To
register this software via email and be eligible for limited technical support, please send your
name, address, and phone number to "info@virtus.com" with the message subject of "Virtus
WalkThrough VRML Registration".

Technical Support

If you experience technical difficulties, we recommend that you first check your Virtus
WalkThrough VRML documentation and Tutorial. If you can't find the answer to your question,
we can help you best if you call us while sitting at your computer with Virtus WalkThrough VRML
1.0 running. Also, please have your serial number ready to give to us. You'll find it in the Virtus
WalkThrough VRML 1.0 splash screen by selecting "About Virtus WalkThrough VRML..." from
the Help menu.

Technical support is available from 9 a.m. to 6 p.m. EST Monday through Friday. You must
have your serial number or contract service number ready to give to us when you call, fax, or
write us requesting technical support. When you write to us, always include your daytime phone.

Technical Support by Telephone

International customers outside the U.S. and Canada can phone for technical assistance and will
receive special priority to minimize their toll charges. We regret that Virtus Customer Service
cannot place or return technical support calls and faxes outside the U.S. and Canada.

919/467-9700 - Technical Support for Domestic and International Callers
919/460-4530 - Technical Support Fax for Domestic Callers

Technical Support by On-Line Services

Virtus Online World Wide Web: Server: www.virtus.com
The Virtus FTP Internet Host: ftp.virtus.com/pub/virtus
America Online: Select "Go To" and then type "VIRTUS"
CompuServe: Type "GO VIRTUS" at any prompt

Technical Support by Email

Internet Mail may be directed to info@virtus.com
America Online Mail may be directed to VirtusTech
CompuServe Mail may be directed to 75300,3251
AppleLink Mail may be directed to VIRTUS

Virtus Corporate Telephone Numbers

919/467-9700 - Main Number
800/847-8871 - Sales and Product Information
919/460-4530 - Corporate Fax

Virtus Corporate Mailing Address

Virtus Corporation
c/o Technical Support



118 MacKenan Dr., Suite 250
Cary, North Carolina 27511

Troubleshooting
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Glossary
Click Here to Close Glossary 

Active Window
Aspect Ratio
Collision Detection
Color Selector
Coordinates Window
Cross Hair
Depth Control
Depth Window
Design View
Dock
Drawing Tools
Full Screen
Group
Handle
Home
Inflation
Inflation Distance
Inflation Modifier
Lens Focal Length Tool
Levels
Library Item
Library
Magnify Tool
Navigation
Non-Reproducing Guidelines
Observer
Opacity Modifiers
Opaque
Orientation Cube
Placement Modifiers
Preferences
Rendering
Rotation Constraint Tools
Selection - Rectangle Method
Slice List
Slice Tool
Snapshot
Surface Editor
Surface Feature
3-D Object Selector
3-D Surface Selector
Translucent
Transparent
Tumble Editor Tool
Velocity Grid
Virtus World
Walk View
Window

Click Here to Close Glossary 



Modeling Concepts
Click on a subject to learn about it:

Volumetricity

Dimensions

The Virtus Rules of Modeling
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Volumetricity

Space Modeling and Containment

When you draw a 2-D object in the Design View, it becomes a 3-D object in the Walk View. Though the 
object may appear solid in the Walk View, it is actually hollow. Every object has an interior space--it is 
volumetric. Volumetricity has three considerations you should be aware of. The first consideration of 
volumetricity is space modeling, that is, you are able to use Virtus WalkThrough VRML to model space 
itself. Think in terms of space (with infinitely thin walls) defining the environment rather than the 
environment defining the space.

A second consequence of volumetricity is containment. Every object in Virtus WalkThrough VRML knows 
what objects it contains and what object contains it. Containment provides you with some important 
benefits. For example, if you move a container, all objects contained within it also move.

In Virtus WalkThrough VRML, containment is an all-or-none state; an object is either fully contained within
another object or it is distinct from other objects. Objects cannot overlap (but they can be joined at a 
common surface). Unfortunately, it is possible to draw overlapping objects, and the program does not 
warn you if you make this mistake; however, the result of overlapping objects is always the same: the 
three-dimensional rendered objects appear twisted and grotesque and sometimes just plain funky.

If you drag a small object into a larger object, a state of containment will exist when the mouse 
pointer reaches the interior of the large object. The program indicates containment by displaying 
small blocks called containment markers at the vertices of the large object. These markers will 
disappear when you release the mouse button. The figure at the left shows containment markers 
displayed as a small object is being dragged into a large object.

The third consequence of volumetricity is that each object surface has an inside and an outside. 

In Virtus WalkThrough VRML, you can edit the inside or outside of any surface of an object to create 
surface features. Surface features are two-dimensional shapes that can be a different color or a different 
opacity than the object surface. Surface features are used to represent doorways, windows, holes and 
other items. 

Back to Modeling Concepts
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Dimensions

When speaking of three-dimensional space, the coordinate system is usually displayed or 
discribed in X, Y and Z axes (or planes). Such is the Virtus WalkThrough Pro world. Because the Top 
View is the default view when the program is started, the three dimensions are based on the Top View 
rather than the Front View, as in some other 3-D programs.

To demonstrate this, look at your Design View. Notice the rulers on the top edge and left edge of the Top 
View. At the bottom of the left ruler is the letter Y. This indicates the left ruler is associated with the Y 
dimension. At the right of the top ruler is the letter X. This indicates the top ruler is associated with the X 
dimension. So, when viewing or drawing objects in the Top View you are viewing or drawing the XY 
dimensions of objects.

Now, select the Front View from the Design menu. Like the Top View, you will see a ruler on the top edge 
and left edge of the view. But notice at the bottom of the left edge ruler is the letter Z indicating the ruler is
associated with the Z dimension. The top ruler has not changed and is still associated with the X 
dimension. So, when viewing or drawing objects in the Front View you are viewing or drawing the X-Z 
dimensions of objects.

Now, select the right view from the Design menu. Notice the top ruler has changed to Y. So, when viewing
or drawing objects in the Right View you are viewing or drawing the Y-Z dimensions of objects.

To put it another way:

X is the left/right dimension,
Y is the front/back dimension, 
Z is the top/bottom dimension. 

Back to Modeling Concepts
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The Virtus Rules of Modeling

When modeling, you would be wise to adhere to these rules....

1) Do not overlap objects.

2) Non-convex objects are not allowed.

3) Speed and Detail are inversely proportional.

4) Transparent and translucent objects and surfaces (as well as smooth shading) drain processing power.

5) You cannot draw a line. All objects drawn must have depth.

Back to Modeling Concepts
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Virtus Corporation
118 MacKenan Drive, Suite 250
Cary, NC 27511
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Menus
Click on a menu to learn about its functions:

File Menu
Edit Menu
View Menu
Design Menu
Walk Menu
Surface Menu
Tumble Menu
Window Menu
Help Menu

Back to The WalkThrough Interface

Back to Contents



The Tools Pad
The Tools Pad has two modes, one for the Design View and one for the Walk View.

Click on a tool to display its function (for more detailed information, refer to the manual supplied with 
Virtus WalkThrough Pro):



                                                                                                                                                        

Back to The WalkThrough Interface 
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The Design View
The Design View is a drawing area where you draw or view object outlines in two dimensions. There are 
six different Design Views: Top, bottom, Front, Back, Left, Right. You may draw in any Design View. More 
than one Design View can be open at any time; however, only one view can be active at any time.
The Design Views have a specific set of tools. When a Design View is active, the Design View tools are 
displayed in The Tools Pad.

Creating an Object

In the Design Views, an object is represented by a 2-D polygonal outline. To draw the polygonal outline of 
an object, select a drawing tool, point to a location in the active design view, click and drag.
The resulting polygonal outline is a 2-D cross section from which a 3-D object is derived. The polygonal 
outline may look flat, but it has depth and a position in space. WalkThrough Pro applies an inflation 
distance, or depth, to the outline and inflates the object in the same direction that you are viewing; you 
cannot see the inflation unless you change views.To change views, select a view from the Change View 
submenu under the View menu.

Back to The WalkThrough Interface 
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The Walk View
The Walk View displays a three-dimensional rendering of the objects that you draw in a Design View. In 
the Walk View, you can walk around and through objects by moving the mouse. Also in this view, you can 
select objects or object surfaces to be edited. The Walk View has a set of tools specific to the Walk View. 
When the Walk View is active, the Walk View Tools are displayed in the Tools Pad.
To move forward, click the mouse about two inches above the cross hair.
To move backward, click the mouse about two inches below the cross hair.
To rotate left/right, click the mouse about two inches to the left/right of the cross hair

ADVANCED NAVIGATION:
                                                                            Press Crtl and                                                                       
Press Shift and
To                                                place cursor                                        To                                                 
place cursor

----------------------------------------------------------------------------------------------------------------------------
-------------
Rise Up                                            Above cross hair                                            Tilt your view up             
Above cross hair                              
Sink Down                                  Below cross hair                                              Tilt your view down          
Below the cross hair
Slide Right                                Right of cross hair                                          Roll your view right            
Right of cross hair
Slide Left                                      Right of cross hair                                          Roll your view left            
Left of cross hair 

Back to The WalkThrough Interface 
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File Menu
Many of the WalkThrough Pro File menu options and commands are standard for the Windows operating 
system. These include New, Open, Close, Save, Save As, Print Setup, Print and Quit. If you are 
unfamiliar these options and commands, please review your Windows system documentation.

New 
New creates and opens a new WalkThrough VRML file.

Open... 
Open displays the standard Windows Open dialog from which you can select an existing file to open. 

Close
Close closes the current file. If you made any changes to the file since the last time you saved it, you 
will be prompted to save the changes before the file is closed.

Save 
Save saves the current file under the currently used name.

Save As...
Save As... opens the standard Windows Save As dialog that allows you to save the current file under 
a new name.

Revert to Saved
Revert To Saved opens the last saved version of the current file. If you select this option, any changes
made to the model since the last time you saved it will be lost unless you first use Save As and save 
the changes to the file under another name.

Print
Print prints the active window centered on the page and enlarged within the constraints of the page. 
What you see is what will print. 

Print Setup
Print Setup opens the standard Windows dialog with which you choose printout size, paper 
orientation and other printing features.

Export
Export allows you to save the currently open WalkThrough VRML file to the standard VRML    file 
format.

Snapshot
Snapshot allows you to save a view of a WalkThrough VRML model in BMP file format. The saved 
view can be a particular perspective in the Walk View, the drawing in a Design View, the Surface 
Editor window, the Tumble Editor window, the Lighting Editor window or a recorded walk path. 

Library
Library allows you to create a new object library or open an existing object library. Choosing Library 
displays the standard Open dialog from which you can select an existing library to open. In addition to
the standard dialog buttons, the New button is displayed, which allows you to create a new library. 
Once a library is open, Library items can be added to or copied from the library. Only one library may 
be open at any time.

Exit 
Exits WalkThrough VRML. If a model is open and changes were made since the last time it was 



saved, you will be prompted to save any changes before exiting.

Back to List of Menus 



Edit Menu

Undo 
Undo undoes the last operation. This command is available in the Design Views as well as all Editors.

Cut 
Cut removes any selected objects, surface features or slices and places them in the Clipboard. Cut 
objects, surface features and slices can then be pasted with the Paste command.

Copy 
Copy copies any selected objects, surface features or slices to the clipboard. The difference between 
Copy and Cut is that Copy leaves the original in place, and Cut removes the original. Copied objects, 
surface features and slices can then be pasted with the Paste command.

Duplicate
Duplicate makes an exact copy of any selected object or surface feature and places it on or near the 
original. Duplicate does not copy to the Clipboard as does the Copy command.

Paste 
Paste pastes the contents of the Clipboard into the model. Clipboard contents can include objects, 
surface features or slices. Different rules apply for where these types of Clipboard content can be 
pasted. For example, you cannot paste a slice in the Design View because a slice has no meaning 
there. A slice can be pasted in the Tumble Editor. Similarly, surface features have meaning only in the 
Surface Editor, and object polygonal outlines have meaning only in the Design View.

Delete 
Delete removes (deletes) selected objects, surface features or slices without placing them into the 
Clipboard. Selected objects, surface features and slices can also be deleted by pressing the Delete 
key. The difference between Cut and Delete is that Delete removes objects completely, whereas Cut 
removes objects to the Clipboard so that they may be pasted again. 

Modify Selected
Modify Selected is a pull-out submenu of modifiers that may be applied to selected objects in the 
Design View and to selected surface features in the Surface Editor. If a particular option is not 
available, it will be grayed. If the Walk View is active, all options are gray.

Select All 
Select All selects all objects (displays all handles). If your entire model is being created as a library 
item, use the Select All command to select all the objects and then group them with Group under the 
Design menu.
All objects can also be selected by double-clicking the Select Object Tool .

UnSelect All 
UnSelect All unselects objects or surface features (removes handles). Another method of unselecting 
is clicking on the background in the Design View or Surface Editor.

Hide Selected 
Hide Selected hides selected objects and surface features. Hiding objects or surface features allows 
you to work with overlapping objects or surface features without having to shuffle them.

Show All
Show All displays all objects or surface features that have been hidden with either the Hide Object 
Tool or the Hide Selected command.



Lock Selected
Lock Selected locks selected objects in the Design View and selected surface features in the Surface 
Editor. Locking objects or surface features prevents them from being edited. When an object or 
surface feature is locked, its polygonal outline is dotted rather than solid.

UnLock All
Unlock All unlocks all objects or surface features locked with the Lock Object Tool    or with the Lock 
Selected command to allow editing.

Preferences
Preferences opens the Preferences dialog. The Preferences dialog allows you to set preferences for 
the appearance of the Design and Walk Views, navigation, measurement units and other application 
and model attributes. With the Preferences dialog, you can customize your application.

Back to List of Menus 



View Menu
The View menu allows you to open new Design Views, change an open Design View to another view, 
make the Walk View active and manipulate the position of the Observer and the center of the active 
view.

Change View
Change View is a pull-out submenu that lists possible Design Views to which the current Design View 
window can be changed. Change View is only available when a Design View or the Surface Editor is 
active. If an option in the Change View submenu is not available, it will be grayed.
The Change View options are Top, Bottom, Front, Back, Left, Right and Opposite.

New View
New View is a submenu that lists possible views that can be opened in a new window. The new views
that you can open include the Design Views and the Walk View.

Set Home to Editor
Set Home to Editor specifies home as the center of the current Design View window. By using the 
home position as a reference point, you can quickly move the Observer or the center of the active 
Design View to the home position from anywhere in the Design View window. To move the Observer 
home, use the Home Observer command. To move the center of the Design View home, use the 
Home Editor command.

Set Home to Observer
Set Home to Observer specifies home as the position of the Observer. By using the home position as 
a reference point, you can quickly move the Observer or the center of the active Design View to the 
home position from anywhere in the active Design View window. To move the Observer home, use 
the Home Observer command. To move the center of the Design View home, use the Home Editor 
command.

Home Editor
Home Editor returns the center of the active Design View to the home position. Home is specified with
the Set Editor to Home command, the Set Observer to Home command or in the Preferences, 
Defaults dialog.

Home Observer
Home Observer returns the Observer to the home position. Home is specified with the Set Editor to 
Home command, the Set Observer to Home command or in the Preferences, Defaults dialog.

Center Observer
Center Observer moves the Observer to the center of the active Design View.

Reset Origin
Reset Origin resets the Origin to true 0,0 coordinates if it has been changed. 

Level Observer 
Level Observer orients the line of sight in the Walk View, making it level if it has been altered with the 
Shift key while navigating.

Back to List of Menus



Design Menu
The Design menu is available only when a Design View is active. If the Surface Editor, Tumble Editor 
or Walk View is active, the Design menu is replaced with the active window's associated menu.

Snap to Grid
Snap to Grid snaps objects, surface features and slices to an invisible grid when they are created, 
moved or edited. The grid is based on the ruler tick marks in the Design View, Surface Editor and 
Tumble Editor. Handles of objects, surface features and slices will "snap to" the grid when Snap to 
Grid is selected.
If you zoom in or out, the ruler tick marks change and, therefore, the invisible grid changes. For 
example, if each tick mark represents one inch, handles snap to the nearest inch. If each tick mark 
represents one foot, handles snap to the nearest foot.

Zoom In 
Zoom In increases the apparent scale and the apparent size of objects in the view by a factor of 2. 
With each Zoom In, the minor tick marks on the rulers represent a smaller unit of measurement. 
There is a limit to the range of the Zoom-In command. When you reach the limit, selecting Zoom In 
will have no affect.

Zoom Out 
Zoom Out reduces the apparent scale and the apparent size of objects in the view by half. With each 
Zoom Out, the minor tick marks on the rulers represent a larger unit of measurement. There is a limit 
to the range of the Zoom-Out command. When you reach the limit, selecting Zoom Out will have no 
effect.

New Layer
New Layer lets you add a new layer to the Layer List. If you select New Layer, a dialog appears with a
text box in which you can type the new layer name.

Delete Layer
Delete Layer deletes the selected layer in the Layer List. If you select Delete Layer you will be 
prompted to verify the deletion.

Group 
Group groups all selected objects treating them a single object. A grouped object can be moved, 
copied, rotated and scaled. It is important to group library items with the Group command before 
copying them to a library. 

UnGroup
UnGroup ungroups selected objects that were grouped with the Group command. Once you ungroup 
an object, all the objects that make up the group remain selected until you click somewhere else 
inside the view. This means that if you want to change the color of a grouped object, you can ungroup
it, select a new color and group the objects again. This only works if you want all objects within the 
group to be the same color.

VRML Anchor
VRML Anchor brings up a dialog box where you can attach a URL (Universal Resource Locator) to an
object or group of objects. For example, to create a link to the Virtus home page, you would type 
http://www.virtus.com.

Back to List of Menus 



Window Menu
The Window menu displays the names of all open windows, views and models, and contains 
commands for displaying the Tools Pad and the Depth window. The Window menu helps you quickly 
navigate through open views and models.

Tools Window
Tools Window displays or hides the Tools Pad. There is only one Tools Pad, though there are several 
sets of tools (see Windows). If the Tools Pad is hidden in one view or editor, it is hidden for all views 
and editors.

Depth Window 
Depth Window displays or hides the Depth window. The Depth window is a ruler, like the Design View
rulers, that contains a Depth Control. The Depth window displays the position and inflation distance 
for the active design view. If you change to another design view, the Depth window will change to 
display the position and inflation distance for the new view.

Coordinates Window
The Coordinates Window identifies the position of the mouse cursor in the active drawing area. The 
information in the Coordinates Window helps you measure and draw accurately. The Coordinates 
Window does not function in the Walk View. 

Back to List of Menus 



Walk Menu
The Walk menu is available only when the Walk View is active. If the Design View, Surface Editor or 
Tumble Editor is active, the Walk menu is replaced with the active window's associated menu.

Button Down
Button Down controls how movement in the Walk View starts and stops. If Button Down is selected (is
checked), movement begins when you press and hold down the mouse button. When you release the
mouse button, movement stops.
If Button Down is not selected, movement stops when you press and hold down the mouse button 
and begins when you release the mouse button.

Cross Hair
Cross Hair turns on and off the display of the cross hair in the center of the Walk View. The cross hair 
orients the mouse pointer when navigating through the model.

Velocity Grid
Velocity grid marks are the horizontal and vertical marks in the Walk View that display the points at 
which walk speed changes. Novice WalkThrough VRML users may find the velocity grid helpful while 
learning to navigate. The default for the velocity grid marks is off (not visible). 

Normal Speed
Normal displays all translucent and transparent object surfaces and surface features, and displays 
object color fill and wire frames.

Fast
Fast displays all translucent and transparent object surfaces and surface features and displays object 
color fill and wire frames, but does not display textures. 

Faster
Faster speeds up your walk through by not allowing you to see through transparent or translucent 
object surfaces or surface features.

Fastest
Fastest speeds up your walk through by displaying only wire frames of objects; no object color fill is 
displayed.

Record
Record allows you to record a walk path. You may also record a walk path by selecting the Record 
Tool    in the Tools Pad. Record allows access to the recording function when in Full Screen mode.

Play
Play allows you to play back a recorded walk path. You may also play back a walk path by selecting 
the Playback Tool    in the Tools Pad. Play allows access to the playback function when in Full Screen 
mode.

Stop
Stop stops a recorded walk path if one is playing. You may also stop a recorded walk path by 
selecting the Stop Tool in the Tools Pad.

Aspect Ratio
Aspect Ratio reads the aspect ratio setting in the Preferences, Navigation dialog and applies it to the 
Walk View.



Full Screen
Full Screen opens the Walk View window to fully cover your computer screen, including the Menu 
Bar. The Menu Bar is still there, but it is hidden. If you point to the normal position of the Menu Bar, 
you can still pull down the menus.
To change back to a normal screen mode, find the Walk menu by pointing to its normal position and 
select Full Screen again.

Back ot List of Menus 



Help Menu
The Help menu allows you to search an on-line text file for help with WalkThrough VRML. The Virtus 
WalkThrough VRML 1.0 Help System is meant as an on-line reference guide only. It does not contain 
any tutorial information. The Help System is intended as a supplement to the manual supplied with 
this software, NOT a replacement. Please refer to the manual for more detailed descriptions and 
guides about WalkThrough VRML.
The Help menu is a standard Windows menu. See your Windows documentation for more about the 
Help menu.

Contents
Contents displays an alphabetical listing of all topics available in the on-line help file. 

Search for Help On
Search for Help On allows you to enter a text string to search for specific information within the on-
line help file.

How to Use Help
How to Use Help displays information about the Windows Help menu system and instructions for its 
use.

About WalkThrough VRML
About WalkThrough VRML displays the version number and copyright notice for your WalkThrough 
VRML application.

Back to List of Menus 



Virtus VR
Virtus VR is a unique 3-D modeling program that features an intuitive drag-and-drop 
approach to world creation. This method of object-oriented drawing allows users to 
choose basic 3-D shapes, from galleries supplied with the program, to build more 
complex objects and structures. Retailing for just $99, this affordable program features 
one cubic mile of cyberspace, construction and navigation tools, galleries of 3-D objects 
that can be added to any Virtus VR environment and six pre-built scenes that illustrate the 
program's modeling, texture mapping and real-time "walkthrough capabilities". The 
program is also supplemented by an on-going series of add-on galleries that greatly cut 
down on modeling time by providing commonly used, pre-constructed 3-D objects that 
bring life to virtual worlds. Virtus VR is available for Macintosh, Power Macintosh and 
Windows users.

To Order Virtus VR, call 1-800-847-8871 (1-800-VIRTUS1) 9:00am - 6:00pm EST

Windows System Requirements:

¥ 80386-based (or later) personal computer                                                                    
¥ at least 4MB
¥ Microsoft Windows 3.1+
¥ VGA or SuperVGA display adapter

Virtus WalkThrough Pro 2.0
Virtus Galleries  
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Virtus WalkThrough Pro 2.0
Discover Virtus WalkThrough Pro, a powerful and intuitive 3-D visualization program that features robust 
modeling and editing tools, perspective-correct texture mapping, and the most effective and affordable 
combination of real-time 3-D rendering and walk through navigation available. With our award-winning 
program, you can envision, create and explore any idea without leaving your desktop. Build in our 2-D 
Design View and watch as your work is rendered instantly in a companion 3-D Walk View. Use texture 
mapping to add realistic surface details such as doors and windows, bricks and tile, landscapes, even 
corporate logos. Bring in a QuickTime movie (Macintosh version only) to enliven 3-D multimedia 
presentations. At any time, use your mouse or keyboard to quickly navigate in, around and through your 
models. And with Virtus Player, our freeware publishing utility and real-time player that ships with 
WalkThrough Pro, you can share your 3-D models with clients, collegues, friends and family who dont 
have Virtus software. Virtus WalkThrough Pro 2.0 is available for Macintosh, Power Macintosh and 
Microsoft Windows.

Windows System Requirements:

¥ 80386-based (or later) personal computer (Pentium recommended)                                                                    
¥ at least 4MB
¥ Microsoft Windows 3.1+
¥ VGA or SuperVGA display adapter

Virtus VR

Virtus Galleries
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Virtus Galleries
Virtus Galleries are extremely useful because they provide many preconstructed 3-D objects and 
scenes that you can use in building your own models whether its an item or an entire room. Virtus 
Galleries are fully compatible for use with Virtus WalkThrough VRML (except for textures), Virtus VR and 
Virtus WalkThrough Pro 2.0. 

To date, the Virtus gallery topics include:

Alphabet Rooms
      Explore and modify virtual rooms based on letters of the alphabet.
      - 26 scenes, including A is for Art, H is for House, M is for moon, etc.
      - virtual alphabet blocks.
      - 3-D galleries featuring numbers, and upper and lower case letters.
      - textures including more than 100 colorful enamels, paints, minerals and more.

Archaeology
      Explore and modify ancient ruins, temples, pyramids and more. 
      - 17 scenes, including the Temple of Neptune, Great Pyramid and Stonehenge. 
      - 3-D galleries featuring Roman and Viking weapons, temple parts, kitchen equipment and more. 
      - 2-D galleries featuring many openings and entrances.
      - textures including stone, hieroglyphics, tiles and more.

Home Remodeling
      Remodel your living space to create your dream home. 
      - 5 scenes, including a beach cabin, mountain home and country club estate.
      - 27 models, featuring bathrooms, kitchens, living rooms, bedrooms, garages and more.
      - 2-D galleries with home doors and windows (opaque, translucent and transparent).
      - textures for indoors and outdoors.

Interior Design
      Use the creations of famous designers to furnish your home or business. 
      - 12 scenes, including the Berlin House (Mies van der Rohe), Glass House (Philip Johnson) and 
Fallingwater (third floor, Frank Lloyd Wright).
      - 11 models of sample rooms and suites.
      - 2-D galleries with various styles of windows and doors.
      - textures including cabinet surfaces, ceiling panels, wallpaper, cloth and more.

Office Design
      Rearrange or redesign your work space. 
      - 5 scenes, including a general office, teleconference center and reception/conference room.
      - 3-D galleries featuring desks, office equipment (copiers, computers, etc.), office furnishings and 
modular conference and storage units.
      - 2-D galleries of doors and windows.
      - textures including wood, stone, leather, tile and more.

Science Fiction
      Build or modify fantasy worlds from far, far away. 
      - 5 scenes, including Dragonfly, Mirror World and Stellar Ark.
      - 45 models, including space stations, vehicles and astronauts.
      - 3-D galleries featuring spaceships, space vehicles, dissecting table and DNA dusters.
      - 2-D galleries of windows and doors.
      - textures including celestial bodies, lunar surface, starfields and more.
 

To Order Virtus Galleries, call 1-800-847-8871 (1-800-VIRTUS1) 9:00am - 6:00pm EST



Virtus VR 

Virtus WalkThrough Pro 2.0
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Tumble Menu
The Tumble menu is available only when the Tumble Editor is active. If the Design View, Surface 
Editor or Walk View is active, the Tumble menu is replaced with the active window's associated menu.

Snap to Grid
Snap to Grid snaps slices to an invisible grid when slices are created, moved or edited. The grid is 
based on the ruler tick marks. Handles of slices will "snap to" the grid when Snap to Grid is selected.

Zoom In
Zoom In increases the apparent scale and the apparent size of objects and surface features in the 
view by a factor of 2. With each Zoom In, the minor tick marks on the rulers represent a smaller unit of
measurement. There is a limit to the range of the Zoom In command. When you reach the limit, 
selecting Zoom In will have no affect.

Zoom Out
Zoom Out reduces the apparent scale and the apparent size of objects and surface features in the 
view by half. With each Zoom Out, the minor tick marks on the rulers represent a larger unit of 
measurement. There is a limit to the range of the Zoom Out command. When you reach the limit, 
selecting Zoom Out will have no affect.

Reverse Slice
Reverse Slice changes which side of a slice is removed. The direction in which the slice is drawn 
through an object determines which side of the object is removed. If you drag from left to right or from 
top to bottom, the portion above or to the right of the line will be sliced off. If you drag from right to left 
or from bottom to top, the portion below or to the left of the line will be sliced off. Reverse Slice 
changes the slice direction.
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The Color Lifter Tool
By selecting this tool and then clicking on a surface in the Design View, that surfaces color 
becomes the currently selected color. (The Color Lifter cannot be used in the Walk View.)



The Magnify Tool
Each click of the Magnify Tool (in the Design View only) increases the apparent sixe of the 
drawing by a factor of two.There is a limit to how closely you can zoom in. When you reach the limit, 
clicking the Magnify Tool    will have no effect.
You can also zoom in by selecting Zoom In under the Design menu.

Zoom-Out Tool    
This tool is accessed by selecting the Magnify Tool    and pressing the Ctrl key. Each click of the Zoom-
Out Tool    decreases the apparent size of the drawing by a factor of 2. There is a limit to how far you can 
zoom out. When you reach the limit, clicking the Zoom-Out Tool      will have no effect.
You can also zoom out by selecting Zoom Out under the Design menu.



Select Object Tool
The Select Object Tool is used to select and edit objects. The Select Object Tool is used in the Design 
Views, Surface Editor and Tumble Editor. In the editors, the Select Object Tool functions differently than in
the Design Views.
If you are working with another tool and wish to use the Select Object Tool , press the space bar and the 
Select Object Tool will automatically be selected. Press the space bar again to go back to the previously 
selected tool.
In the Design Views and Surface Editor, the Select Object Tool is used to select, move and       
change the size or shape of objects and surface features.



Tape Measure Tool
The Tape Measure Tool    finds the distance between two points. The distance is displayed in 
the Coordinates Window. (See Coordinates Window in your WalkThrough Pro Manual.)



Scale Object Tool
The Scale Object Tool    functions in the Design Views or Surface Editor, and scales an object or surface 
feature about its center or about a specified anchor point. 
Objects may be scaled independently along any of the three coordinate axes. 
Objects may also be scaled uniformly in all dimensions (X, Y and Z) by holding down the Shift key before 
dragging.
When an object is scaled, its contents and any surface features are scaled with it unless you hold down 
the Ctrl key while you are dragging.



Lock Object Tool
The Lock Object Tool    functions in the Design Views and in the Surface Editor, and allows you to lock 
objects or surface features so they cannot be edited. A locked object or surface feature appears with a 
dotted polygonal outline rather than a solid outline.



Create 8-Sided Object Tool
The Create 8-Sided Object Tool draws an 8-sided polygonal object outline or surface feature. 



Create Irregular Object Tool
The Create Irregular Object Tool    draws an irregular-shaped polygonal outline, one segment at a time. 
This tool does not draw non-convex objects or surface features.



Create Rectangular Object Tool
The Create Rectangular Object Tool draws a rectangular polygonal outline. 



Connect Surfaces Tool
The Connect Surfaces Tool functions in the Design View and is used to connect two objects together at a 
common surface. A connection between surfaces is necessary to see any common surface features such 
as the colored, transparent or translucent surface features representing doorways or windows. Without 
the connection, surface features between objects will not be shared and holes will not penetrate both 
surfaces. 
A common misconception is that a connection will increase speed. This is not true. A connection should 
be made only where necessary, that is, where surface features are shared between two objects.



Add / Remove handle Tool
The Add/Remove Handle Tool    functions in the Design View and the Surface Editor, and is used to add a 
new handle to an object or surface feature or to remove an existing handle. A handle represents a vertex -
the meeting of two object surfaces. 



Rotate Object Tool
The Rotate Object Tool    functions in the Design Views and the Surface Editor, and is used to rotate an 
object or surface feature. When rotating an object, this tool works in any view, thus allowing rotation on 
more than one axis.



Surface Editor Tool
The Surface Editor Tool    functions in the Design Views and Tumble Editor and accesses the Surface 
Editor.



The Tumble Editor
The Tumble Editor Tool functions in the Design Views and accesses the Tumble Editor. The Tumble Editor
allows you to add a surface to a selected object by slicing off a piece of the object. The Tumble Editor 
also allows you to edit the color and opacity of a selected object or object surface. 



The Opacity Modifiers
Opacity Modifiers function in the Design Views, the Surface Editor and the Tumble Editor; these edit the 
opacity of entire objects, selected object surfaces or surface features. Object surfaces can be modified in 
the Tumble Editor or the Surface Editor, and surface features can be edited only in the Surface Editor.



The Inflation Modifiers
The Inflation Modifiers determine the inflation type, or shape, of an object. Inflation is the process of 
creating a 3-D object from a 2-D polygonal outline. The distance and the direction of object inflation are 
determined by the Depth Control Gauges.



Walk Mode Selector
The Walk Mode Selector, which enables navigation, is the default setting for the Walk View



The 3-D Object Selector
The 3-D Object Selector selects an object in the Walk View and centers that object in the 
Design View. When an object is difficult to locate in a complex model, the 3-D Object Selector is very 
helpful.



The 3-D Surface Selector
The 3-D Surface Selector allows the selection of an object's surface from the Walk View. This feature 
works just like the Design View's Surface Editor. A special feature of this tool allows for the surface 
selection of a grouped object (i.e. a chair or sofa as a library object).



Background Color Selector
The Color Bar at the top of the Tools Pad is the Background Color Selector used to change the color of 
the background within the Walk View. 

Changing the background color
Mouse down on the Background Color Selector (Color Bar) that is used to reveal the color selector. Drag 
the mouse to the desired color and release.



The Lens Focal Length Tool
The lens size indicator and the sliding control beneath it are both parts of the Lens Focal Length Tool. If 
the sliding control is moved, the reading in the lens size indicator will change to display the new lens focal
length. You can also adjust the lens focal length by highlighting the numbers in the lens size indicator, 
then typing a new number and pressing the Enter/Return key. You must press the Enter/Return key for 
the change to take effect.



Color Bar
The Color Bar functions in the Design Views, the Surface Editor and the Tumble Editor, and displays the 
default color for new objects. It also allows new colors to be selected, created and assigned to objects or 
surface features. Colors can be applied to translucent as well as opaque objects and surfaces.
The current color displayed in the Color Bar is the default color for all newly created objects or surface 
features. The default color and the color of existing objects or surface features can be changed.



The Orientation Cube
The Orientation Cube shows the orientation of the Observer inside the Virtus world. If any objects can be 
seen, the Orientation Cube will indicate the side(s) of the objects that the Observer is facing: F=Front, 
B=Back, L=Left, R=Right, T=Top, b=bottom.
You can always tell your orientation in the model by noting the display of the Orientation Cube. It is 
especially helpful in orienting you when viewing a model that someone else has created.
The Orientation Cube also appears in the Tumble Editor, but has added functionality there.    



Record, Playback Path
As you navigate through a model in the Walk View, you can record and later play back the walk path with 
the Record Tool    and Playback Tool . 
The length of a recording is limited only by memory; however, it is unlikely that you will run out of memory 
because the requirement is small.
When you save a file, the recorded walk path is saved with it. When you open the file again, you can click 
the play button and view the recording. Only one recorded path can be saved with each model. If you 
record another, the previous path will be erased.



Surface Menu
The Surface menu is available only when the Surface Editor is the active window. If the Design View, 
Tumble Editor or Walk View is active, the Surface menu is replaced with the active window's 
associated menu.

Snap to Grid
Snap to Grid snaps surface features to an invisible grid when they are created, moved or edited. The 
grid is based on the ruler tick marks. Handles of surface features will "snap to" the grid when Snap to 
Grid is selected.

Zoom In
Zoom In increases the apparent scale and the apparent size of objects and surface features in the 
view by a factor of 2. With each Zoom In, the minor tick marks on the rulers represent a smaller unit of
measurement. There is a limit to the range of the Zoom In command. When you reach the limit, 
selecting Zoom In will have no affect.

Zoom Out
Zoom Out reduces the apparent scale and the apparent size of objects and surface features in the 
view by half. With each Zoom Out, the minor tick marks on the rulers represent a larger unit of 
measurement. There is a limit to the range of the Zoom Out command. When you reach the limit, 
selecting Zoom Out will have no affect.

Move Forward
Used with multiple surface features that overlap, Move Forward shuffles the order of the overlapping 
features by moving a selected surface feature forward one position. For example, if the selected 
surface feature has three surface features in front of it, Move Forward will cause only two surface 
features to be moved in front of the selected feature. The third surface feature will move behind the 
selected feature.

Move to Front
Used with multiple surface features that overlap, Move to Front shuffles the order of the overlapping 
features by moving a selected surface feature to the front of all the overlapping features.

Move Back
Used with multiple surface features that overlap, Move Back shuffles the order of the overlapping 
features by moving a selected surface feature back one position. For example, if the selected surface 
feature has two surface features in front of it and two behind it, Move Back will cause three surface 
features to be moved in front of the selected feature and only one behind it.

Move to Back
Used with multiple surface features that overlap, Move to Back shuffles the order of the overlapping 
features by moving a selected surface feature to the back of all the overlapping features.
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Active Window
The window that you are currently working in. A window is active if its Title Bar is 
highlighted.



Aspect Ratio
The ratio of horizontal to vertical dimensions of the Walk View.



Collision Detection 
Collision Detection is the feature that prevents you from walking through walls and other 
solid objects. 



Color Selector
A spectrum of colors that can be assigned to objects or surface features.



Coordinates Window
The Coordinates Window displays object and cursor positions/measurements within the 
Design View.



Cross Hair
Located in the middle of the Walk View and used as a reference point for navigation.



Depth Control
Appears on each ruler in the Design Views and on the ruler in the Depth Window. It 
determines the inflation distance and the position of objects.



Depth Window
Contains a ruler and Depth Control that allow you to manipulate inflation distance and 
position of objects.



Design View
A two-dimensional area where you draw objects. There are six possible Design Views: Front, 
Back, Top, Bottom, Left and Right.



Drawing Tools
Allow you to draw 2-D polygonal outlines of basic shapes that are interpreted as 3-D objects 
or 2-D surface features.



Full Screen
This command opens the Walk View to cover the entire monitor screen, including the menu 
bar.



Group
This command groups all selected objects, treating them as a single object.



Handle
A small square block which represents the meeting of two or more planes, or in the case of 
an object, the meeting of two sides. If an object is selected, its handles are visible.



Home
A 3-D location in the Virtus World used as a base or reference for the Observer or for a 
Design View.



Inflation
The process of taking a 2-D polygonal outline and adding depth to create a 3-D object.



Inflation Distance
The depth or the distance that a 2-D polygonal outline is stretched to create a 3-D object.



Inflation Modifier
Determines the inflation type, or 3-D shape, of an object. Inflation is the process of 
interpreting a 2-D polygonal outline in the Design Views as a 3-D object in the Walk View.



Lens Focal Length Tool
Determines the zoom factor of the virtual camera. The Lens Focal Length Tool can be 
adjusted to give the effect of viewing the Walk View through a wide angle lens or a telephoto
lens.



Levels
The number of decrementing sides of an object whose inflation type is rounded or double-
rounded. The maximum number of levels allowed is 16.



Library Item
Can be a single Virtus WalkThrough VRML object, but is usually several objects grouped 
together to form a complex shape, such as a piece of furniture. Library Items are stored in a 
Virtus WalkThrough VRML Library.



Library
A collection of Virtus WalkThrough VRML objects (Library Items) that can be copied and 
pasted into multiple models.



Magnify Tool
The Magnify Tool increases the apparent size of the Design View drawing by factor of two, 
every time you click.



Navigation
The process of moving through the Walk View.



Non-Reproducing Guidelines
These help align objects. Non-Reproducing Guidelines are dragged out of the Dock and 
positioned anywhere on the ruler.



Observer
Represents your eyes in the virtual environment. In a Design View, the Observer is shown as 
a circle with a line that indicates the viewing direction.



Opacity Modifiers
Determine whether an entire object or a selected surface is opaque, translucent or 
transparent.



Opaque
Describes a selected object or surface feature that appears solid (you cannot see through it),
even though it is volumetric.



Orientation Cube
Shows the orientation of the Virtus World as seen by the Observer in the Walk View. In the 
Tumble Editor, the Orientation Cube represents the selected object within the Virtus World 
and shows the side(s) of the object visible in the tumble window.



Placement Modifiers
Determine which side of a surface will be edited.



Preferences
The dialog box that allows you to set preferences for the appearance of the Design and Walk
Views, navigation, measurement units and other application and model attributes. You can 
customize your application with the Preferences dialog.



Rendering
Translation of 2-D objects in the Design View to 3-D objects in the Walk View.



Rotation Constraint Tools
These affect how the selected object can be rotated.



Selection - Rectangle Method
A means to select objects by dragging the Select Object Tool to form a bounding box around 
the objects that you wish to select.



Slice List
Displays the word slice and a number for each slice that you make in an object while in the 
Tumble Editor. If you wish to edit a slice, click on the slice number of the slice and it will 
appear in the Tumble window.



Slice Tool
Adds a surface to an object by slicing off a piece of that object in the Tumble Editor.



Snapshot
This command allows you to save a Design View or Walk View perspective in BMP format.



Surface Editor
Accesses the Surface Editor from the Design Views or the Tumble Editor. The Surface Editor 
allows you to edit a selected object surface.



Surface Feature
A polygonal 2-D object that can represent items such as a door, window, or a floor or wall 
feature with a specified opacity and color on a surface. Surface Features are created and 
edited in the Surface Editor with the same tools as objects; however, Surface Features do 
not have depth.



3-D Object Selector
The 3-D Object Selector is the tool used to select an object in the walk view.



3-D Surface Selector
The 3-D Surface Selector is the tool used to select surfaces in the Walk View.



Translucent
Means that a selected object or surface feature is see-through, like glass.



Transparent
Means a selected object or surface feature is invisible except for a wire frame.



Tumble Editor Tool
Accesses the Tumble Editor from the Design Views. The Tumble Editor allows you to three-
dimensionally rotate an object, edit a selected surface or slice off a piece of an object.



Velocity Grid
This is made up of the horizontal and vertical marks in the Walk View that determine the 
points at which the walk speed changes when you navigate through the Virtus World.



Virtus World
The overall area of the Walk View.



Walk View
The window that displays a three-dimensional rendering of the objects you draw in a Design 
View and allows you to walk through and around the objects.



Window
Displays information on the computer screen in a designated area. In Virtus WalkThrough 
VRML, a window can display a tool palette, a view or an editor.



Dock
A gray box that appears on the end of each ruler. The Dock displays the letter, X, Y or Z, 
which determines the axis the ruler is on. Docks also contain Non-Reproducing Guidelines, 
which you can drag to any position on the ruler.

 




